Chapter 460

Two-Sample T-Tests for Equivalence Assuming Equal Variance

Introduction

This procedure allows you to study the power and sample size of equivalence tests of the means of two independent groups using the two-sample equal-variance t-test. Schuirmann’s (1987) two one-sided tests (TOST) approach is used to test equivalence. Only a brief introduction to the subject will be given here. For a comprehensive discussion, refer to Chow and Liu (1999).

Measurements are made on individuals that have been randomly assigned to one of two groups. This parallel-groups design may be analyzed by a TOST equivalence test to show that the means of the two groups do not differ by more than a small amount, called the margin of equivalence.

The definition of equivalence has been refined in recent years using the concepts of prescribability and switchability. Prescribability refers to ability of a physician to prescribe either of two drugs at the beginning of the treatment. However, once prescribed, no other drug can be substituted for it. Switchability refers to the ability of a patient to switch from one drug to another during treatment without adverse effects. Prescribability is associated with equivalence of location and variability. Switchability is associated with the concept of individual equivalence. This procedure analyzes average equivalence. Thus, it partially analyzes prescribability. It does not address equivalence of variability or switchability.

Parallel-Group Design

In a parallel-group design, subjects are assigned at random to either of two groups. Group 1 is the treatment group and group 2 is the reference group.
Outline of an Equivalence Test

PASS follows the two one-sided tests approach described by Schuirmann (1987) and Phillips (1990). Let \( \mu_1 = \mu_T \) be the test group mean, \( \mu_2 = \mu_R \) be the reference group mean, and \( E_L \) and \( E_U \) be the lower and upper bounds, respectively, on \( \delta = \mu_1 - \mu_2 = \mu_T - \mu_R \) that define the region of equivalence.

It will be convenient to adopt the following specialized notation for the discussion of these tests.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PASS Input/Output</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \mu_1 ) or ( \mu_T )</td>
<td>Not used</td>
<td>Mean of population 1. Population 1 is assumed to consist of those who have received the new treatment.</td>
</tr>
<tr>
<td>( \mu_2 ) or ( \mu_R )</td>
<td>Not used</td>
<td>Mean of population 2. Population 2 is assumed to consist of those who have received the reference treatment.</td>
</tr>
<tr>
<td>( E_L, E_U )</td>
<td>EL, EU</td>
<td>Lower and Upper Equivalence Limits. If the difference is between these two limits, the new treatment is said to be equivalent to the reference.</td>
</tr>
<tr>
<td>( \delta )</td>
<td>( \delta )</td>
<td>Actual difference. This is the value of ( \mu_1 - \mu_2 ), the difference between the means. This is the value at which the power is calculated.</td>
</tr>
</tbody>
</table>

Note that the actual values of \( \mu_1 \) and \( \mu_2 \) are not needed. Only their difference is needed for power and sample size calculations.

With \( E_L < 0 \) and \( E_U > 0 \), the null hypothesis of non-equivalence is

\[
H_0: \delta \leq E_L \text{ or } \delta \geq E_U.
\]

The alternative hypothesis of equivalence is

\[
H_1: E_L < \delta < E_U.
\]

Two-Sample Equal-Variance T-Test Statistics

This test assumes that the two groups of normally-distributed values have the same variance. The calculation of the two one-sided test statistics uses the following equations.

\[
t_L = \frac{(\bar{X}_1 - \bar{X}_2) - E_L}{s_{\bar{X}_1 - \bar{X}_2}}
\]

\[
t_U = \frac{(\bar{X}_1 - \bar{X}_2) - E_U}{s_{\bar{X}_1 - \bar{X}_2}}
\]

where

\[
\bar{X}_k = \frac{\sum_{i=1}^{n_k} X_{ki}}{n_k}
\]

\[
s_k = \sqrt{\frac{\sum_{i=1}^{n_k} (X_{ki} - \bar{X}_k)^2}{(n_k - 1)}}.
\]

\[
s_{\bar{X}_1 - \bar{X}_2} = \sqrt{\frac{(n_1 - 1)s_1^2 + (n_2 - 1)s_2^2}{n_1 + n_2 - 2} \left( \frac{1}{n_1} + \frac{1}{n_2} \right)}.
\]

\[
df = n_1 + n_2 - 2.
\]

The null hypothesis is rejected if \( t_L \) and \( -t_U \) are both greater than or equal to \( t_{1-\alpha, df} \).
Power Calculation

When $\sigma_1 = \sigma_2 = \sigma$, the power of the equal-variance equivalence $t$-test is calculated as

$$\Pr\left(t_L \geq t_{1-\alpha,n_1+n_2-2} \text{ and } t_U \leq -t_{1-\alpha,n_1+n_2-2} | \mu_1, \mu_2, \sigma \right)$$

where $t_L$ and $t_U$ are distributed as the bivariate, noncentral $t$ distribution with noncentrality parameters $\Delta_L$ and $\Delta_U$ given by

$$\Delta_L = \frac{\delta - E_L}{\sigma \sqrt{\frac{1}{n_1} + \frac{1}{n_2}}}$$

$$\Delta_U = \frac{\delta - E_U}{\sigma \sqrt{\frac{1}{n_1} + \frac{1}{n_2}}}$$

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

Solve For

Solve For

This option specifies the parameter to be calculated from the values of the other parameters.

Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha.

Select Power when you want to calculate the power of an experiment that has already been run.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of nonequivalent means when in fact the means are equivalent.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as $0.8 \text{ to } 0.95 \text{ by } 0.05$ may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of non-equivalent means when in fact the means are nonequivalent.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on $N_1$ or $N_2$ or both.

The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter $N_1$, solve for $N_2$**
  Select this option when you wish to fix $N_1$ at some value (or values), and then solve only for $N_2$. Please note that for some values of $N_1$, there may not be a value of $N_2$ that is large enough to obtain the desired power.

- **Enter $N_2$, solve for $N_1$**
  Select this option when you wish to fix $N_2$ at some value (or values), and then solve only for $N_1$. Please note that for some values of $N_2$, there may not be a value of $N_1$ that is large enough to obtain the desired power.

- **Enter $R = N_2/N_1$, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the ratio of $N_2$ to $N_1$, and then PASS determines the needed $N_1$ and $N_2$, with this ratio, to obtain the desired power. An equivalent representation of the ratio, $R$, is $N_2 = R \times N_1$.

- **Enter percentage in Group 1, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed $N_1$ and $N_2$ with this percentage to obtain the desired power.

**$N_1$ (Sample Size, Group 1)**
This option is displayed if Group Allocation = “Enter $N_1$, solve for $N_2$”

$N_1$ is the number of items or individuals sampled from the Group 1 population.

$N_1$ must be $\geq 2$. You can enter a single value or a series of values.

**$N_2$ (Sample Size, Group 2)**
This option is displayed if Group Allocation = “Enter $N_2$, solve for $N_1$”

$N_2$ is the number of items or individuals sampled from the Group 2 population.

$N_2$ must be $\geq 2$. You can enter a single value or a series of values.
Two-Sample T-Tests for Equivalence Assuming Equal Variance

**R (Group Sample Size Ratio)**
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1}. \]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.

N2 is related to N1 by the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \[\lceil Y \rceil\] is the next integer \(\geq Y\).

For example, setting \(R = 2.0\) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \(N1 = 10\) and \(N2 = 20\), or \(N1 = 50\) and \(N2 = 100\)).

R must be greater than 0. If \(R < 1\), then N2 will be less than N1; if \(R > 1\), then N2 will be greater than N1. You can enter a single or a series of values.

**Percent in Group 1**
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2. Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter N1 and N2 individually**
  This choice permits you to enter different values for N1 and N2.

- **Enter N1 and R, where N2 = R * N1**
  Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

- **Enter total sample size and percentage in Group 1**
  Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, and then N2 as \(N - N1\).
Sample Size Per Group

This option is displayed only if Group Allocation = “Equal (N1 = N2).”

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for \( N_1 \), and also the value for \( N_2 \).

The Sample Size Per Group must be \( \geq 2 \). You can enter a single value or a series of values.

\( N_1 \) (Sample Size, Group 1)

This option is displayed if Group Allocation = “Enter \( N_1 \) and \( N_2 \) individually” or “Enter \( N_1 \) and \( R \), where \( N_2 = R \times N_1 \).”

\( N_1 \) is the number of items or individuals sampled from the Group 1 population.

\( N_1 \) must be \( \geq 2 \). You can enter a single value or a series of values.

\( N_2 \) (Sample Size, Group 2)

This option is displayed only if Group Allocation = “Enter \( N_1 \) and \( N_2 \) individually.”

\( N_2 \) is the number of items or individuals sampled from the Group 2 population.

\( N_2 \) must be \( \geq 2 \). You can enter a single value or a series of values.

\( R \) (Group Sample Size Ratio)

This option is displayed only if Group Allocation = “Enter \( N_1 \) and \( R \), where \( N_2 = R \times N_1 \).”

\( R \) is the ratio of \( N_2 \) to \( N_1 \). That is,

\[
R = \frac{N_2}{N_1}
\]

Use this value to obtain \( N_2 \) as a multiple (or proportion) of \( N_1 \).

\( N_2 \) is calculated from \( N_1 \) using the formula:

\[
N_2 = \lceil R \times N_1 \rceil,
\]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1.

\( R \) must be greater than 0. If \( R < 1 \), then \( N_2 \) will be less than \( N_1 \); if \( R > 1 \), then \( N_2 \) will be greater than \( N_1 \). You can enter a single value or a series of values.

Total Sample Size (N)

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines \( N_1 \) and \( N_2 \).

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

Percent in Group 1

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.
Effect Size – Equivalence Limits

EU (Upper Equivalence Limit)
Enter one or more values for the upper limit of equivalence. If the actual difference is between EL and EU, the new treatment is said to be equivalent to the standard. You may enter values in the range $EU > 0$ and $EL < \delta < EU$.

EL (Lower Equivalence Limit)
Enter one or more values for the lower limit of equivalence. If the actual difference is between EL and EU, the new treatment is said to be equivalent to the standard. You may enter values in the range $EL < 0$ and $EL < \delta < EU$.

If you want symmetric limits around zero, enter “-Upper Limit” here. The program will set $EL = -|EU|$.

Effect Size – Mean Difference

$\delta$ (Actual Difference)
This is the actual difference between the treatment mean and the reference mean at which the power is calculated. For equivalence tests, this value is often set to zero. You may enter values in the range $EL < \delta < EU$.

Effect Size – Standard Deviation

$\sigma$ (Standard Deviation)
The standard deviation entered here is the assumed standard deviation for both the Group 1 population and the Group 2 population. $\sigma$ must be a positive number.
Example 1 – Finding Power

A parallel-group is to be used to compare influence of two drugs on diastolic blood pressure. The diastolic blood pressure is known to be close to 96 mmHg with the reference drug and is thought to be 92 mmHg with the experimental drug. Based on similar studies, the within-group standard deviation is set to 18 mmHg. Following FDA guidelines, the researchers want to show that the diastolic blood pressure with the experimental drug is within 20% of the diastolic blood pressure with the reference drug. Note that 20% of 96 is 19.2. They decide to calculate the power for a range of sample sizes between 3 and 60. The significance level is 0.05.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests for Equivalence Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Equivalence, and then clicking on Two-Sample T-Tests for Equivalence Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>3 5 8 10 15 20 30 40 50 60</td>
</tr>
<tr>
<td>EU (Upper Equivalence Limit)</td>
<td>19.2</td>
</tr>
<tr>
<td>EL (Lower Equivalence Limit)</td>
<td>-Upper Limit</td>
</tr>
<tr>
<td>δ (Actual Difference)</td>
<td>-4</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>18</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Lower Equiv Limit</th>
<th>Upper Equiv Limit</th>
<th>δ</th>
<th>σ</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.03856</td>
<td>3</td>
<td>3</td>
<td>6</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.09277</td>
<td>5</td>
<td>5</td>
<td>10</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.28871</td>
<td>8</td>
<td>8</td>
<td>16</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.43913</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.69339</td>
<td>15</td>
<td>15</td>
<td>30</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.82662</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.94326</td>
<td>30</td>
<td>30</td>
<td>60</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.98205</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.99458</td>
<td>50</td>
<td>50</td>
<td>100</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.99843</td>
<td>60</td>
<td>60</td>
<td>120</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4.0</td>
<td>18.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>
Two-Sample T-Tests for Equivalence Assuming Equal Variance

References

Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N = N1 + N2 is the total sample size.
EL and EU are the lower and upper equivalence limits, respectively, and are the maximum allowable differences that still result in equivalence.
δ = μ1 - μ2 = μT - μR is the difference between the treatment and reference means at which power and sample size calculations are made.
σ is the assumed population standard deviation for each of the two groups.
Alpha is the probability of rejecting a true null hypothesis.

Summary Statements
An equivalence test of means using two one-sided equal-variance t-tests with sample sizes of 3 in the treatment group and 3 in the reference group achieves 4% power at a 5.0% significance level when the the equivalence limits are -19.2 and 19.2, the actual difference between the means is -4.0, and the standard deviation is 18.0 in each group.

This report shows the power for the indicated parameter configurations. Note that the desired 80% power occurs for a per group sample size between 15 and 20.

Plot Section

This plot shows the power versus the sample size.
Example 2 – Finding the Sample Size

Continuing with Example 1, the researchers want to know the exact sample size to achieve 80% power.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests for Equivalence Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Equivalence, and then clicking on Two-Sample T-Tests for Equivalence Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>EU (Upper Equivalence Limit)</td>
<td>19.2</td>
</tr>
<tr>
<td>EL (Lower Equivalence Limit)</td>
<td>-Upper Limit</td>
</tr>
<tr>
<td>δ (Actual Difference)</td>
<td>-4</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>18</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Lower Equiv Limit</th>
<th>Upper Equiv Limit</th>
<th>δ</th>
<th>σ</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.80</td>
<td>0.80601</td>
<td>19</td>
<td>19</td>
<td>38</td>
<td>-19.2</td>
<td>19.2</td>
<td>-4</td>
<td>18.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>

This report shows the exact sample size required for 80% power.
Example 3 – Validation using Julious (2010)

Julious (2010) page 87 presents an example of determining the sample size for testing equivalence in a pain control trial in which the margin of equivalence for the difference is ± 10mm, the actual differences are 0mm (Example 5.1) and 2mm (Example 5.2), the standard deviation is 100mm, the power is 90%, and the significance level is 0.025 with equal sample allocation. Julious (2010) calculates the sample sizes to be 2600 for an actual difference of 0mm and 3306 for an actual difference of 2mm.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests for Equivalence Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Equivalence, and then clicking on Two-Sample T-Tests for Equivalence Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
</table>
| Design Tab
| Solve For                      | Sample Size                    |
| Power                          | 0.90                           |
| Alpha                          | 0.025                          |
| Group Allocation               | Equal (N1 = N2)                |
| EU (Upper Equivalence Limit)   | 10                             |
| EL (Lower Equivalence Limit)   | -Upper Limit                   |
| δ (Actual Difference)          | 0, 2                           |
| σ (Standard Deviation)         | 100                            |

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Lower Equiv Limit</th>
<th>Upper Equiv Limit</th>
<th>δ</th>
<th>σ</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90011</td>
<td>2600</td>
<td>2600</td>
<td>5200</td>
<td>-10.0</td>
<td>10.0</td>
<td>0.0</td>
<td>100.0</td>
<td>0.025</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90006</td>
<td>3305</td>
<td>3305</td>
<td>6610</td>
<td>-10.0</td>
<td>10.0</td>
<td>2.0</td>
<td>100.0</td>
<td>0.025</td>
</tr>
</tbody>
</table>

Note that PASS obtains sample sizes of 2600 and 3305, which are equal to those calculated by Julious (2010) with slight differences due to rounding.
Example 4 – Validation using Machin et al. (1997)

Machin et al. (1997) page 107 present an example of determining the sample size for a parallel-group design in which the reference mean is 96, the treatment mean is 94, the standard deviation is 8, the limits are plus or minus 5, the power is 80%, and the significance level is 0.05. They calculate the sample size to be 88. It is important to note that Machin et al. use an approximation, so their results should not be expected to exactly match the results obtained using PASS.

We will now set up this example in PASS.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests for Equivalence Assuming Equal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Equivalence, and then clicking on Two-Sample T-Tests for Equivalence Assuming Equal Variance. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>EU (Upper Equivalence Limit)</td>
<td>5</td>
</tr>
<tr>
<td>EL (Lower Equivalence Limit)</td>
<td>-Upper Limit</td>
</tr>
<tr>
<td>δ (Actual Difference)</td>
<td>-2</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>8</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>Lower Equiv Limit</th>
<th>Upper Equiv Limit</th>
<th>δ</th>
<th>σ</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.80</td>
<td>0.80151</td>
<td>89</td>
<td>89</td>
<td>178</td>
<td>-5.0</td>
<td>5.0</td>
<td>-5.0</td>
<td>8.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>

PASS obtains a sample size of 89 which is very close to the approximate value of 88 that Machin calculated.